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Standardele de elaborare a tezei de doctorat

Principiile si indicatiile din acest document au fost elaborate in acord cu cerintele
Ordinului nr. 3200/2020 privind aprobarea Metodologiei de evaluare a studiilor
universitare de doctorat si a sistemelor de criterii, standarde si indicatori de performanta
utilizati in evaluare, cu prevederile Regulamentul privind organizarea si desfasurarea
studiilor universitare de doctorat in UPB, 2020, precum si cu alte prevederi ale legislatiei
din domeniu, Tn vigoare.

1. Aspecte generale

Teza de doctorat este structurata in mai multe sectiuni, fiecare avand o destinatie
distincta, explicata sintetic mai jos. In general, teza de doctorat va include
capitole/subcapitole/sectiuni /paragrafe.

Pentru redactarea volumul tezei se propun urmatoarele componente:

Coperta exterioara si coperta interioara sau prima pagina a tezei. Acestea cuprind
informatii identice cu deosebirea ca pe coperta exterioara se va mentiona doar titlul
"TEZA de DOCTORAT” in timp ce pe coperta interioara se va mentiona in loc titlul tezei.
Astfel se vor mentiona: denumirea completa a universitatii si a scolii doctorale; numele gi
prenumele autorului; gradul didactic, numele si prenumele conducatorului stiintific;

localitatea Bucuresti si anul sustinerii, conform Modelului de redactare, de mai jos.

Rezumatul de prezentare a tezei (aprox 1500-2000 de caractere), in limba romana si
in limba engleza care prezinta in sinteza rezultatele obtinute si prezentate in teza de catre
doctorand si principalele concluzii ale tezei de doctorat, specificand elementele originale.

(optional) Multumiri — adresate persoanelor care au sprijinit doctorandul in cercetare si
n elaborarea tezei.

Cuprinsul lucrarii propriu-zis - realizat prin intermediul MS Word, in care se inscrie
fiecare capitol, subcapitol, sectiune (in trei sau patru niveluri de structurare) impreuna cu
numerotarea cu cifre arabe aferenta, conform modelului de redactare de mai jos. Prin
selectarea unui capitol/ subcapitol sau sectiune din cuprins, trebuie sa se poata face "salt”
la pagina din teza de unde incepe acel capitol/ sub-capitol / sectiune.

Cuprinsul va fi urmat de o lista de figuri si o listd de tabele generata tot "automat”, cu
aceleasi caracteristici ale cuprinsului propriu-zis al tezei.

2. Indicatii asupra elaborarii continutului tezei

Capitolul - Introducere — descrie cadrul stiintific al temei tezei prin prezentarea detaliata
a:

-importantei temei de cercetate,
-necesitatii si oportunitatea temei,

-scopului cercetarii doctorale si obiectivele propuse pentru cercetare.

Introducerea trebuie sa raspunda la urmatoarele intrebari:
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- care este problema studiata (dificultatile/neajunsuri la care tema va cercetare va gasi
rezolvari)?

- de ce este importanta?
- pentru cine prezinta interes cercetarea?

La final se poate realiza o prezentare pe scurt a structurii tezei printr-o succinta trecere
in revista a continutului capitolelor urmatoare din teza prin care se raspunde la intrebarile
de mai sus.

Capitolul - Stadiul actual al cercetari lor din domeniul tezei, asa cum se prezinta
acesta in literatura stiintifica relevanta.

Acest capitol reprezinta o sinteza a literaturii de specialitate din domeniul temei studiate.
Autorul trebuie sa realizeze o prezentare critica a rezultatelor studiilor din literatura
stiintifica privind subiectul tezei de doctorat $i s& expuna principalele puncte de vedere /
abordari/ teorii ale unor lucrari consacrate in domeniul cercetat. Pot fi analizate si
rezultatele altor teze de doctorat, insa doar marginal, deoarece rezultatele lor nu au
parcurs etape de validare in mediul stiintific si practic.

Doctorandul trebuie sa dovedeasca ca stapaneste temeinic literatura stiintifica privind
tema sa de doctorat.

Conducatorul de doctorat recomanda utilizarea unor referinte reprezentative, iar
doctorandul foloseste pentru documentare mai ales baze de date internationale.

Prezentarea stadiului cunoasterii trebuie realizata intr-o maniera criticd/comparativa, cu
avantajele si limitele lucrarilor. Prezentarea stadiului cunoasterii trebuie sa fie logica,
coerenta si sa fie in relatie directa cu tematica tezei.

Doctorandul foloseste stadiul realizarilor actuale ca un argument important pentru
alegerea obiectivelor sale originale din teza de doctorat.

Scopul este de a descrie ceea ce s-a realizat deja in diferite aspecte ale tematicii de
cercetare si modul in care rezultatele propriei cercetari si investigatiilor din teza
completeaza/ clarifica unele aspecte identificate in literatura cea mai recenta, dar nu
numai.

In fapt, ratiunea unei cercetéari doctorale, la fel ca si aceea a unui nou proiect de cercetare,
este depasirea stadiului actual al cunoasterii, adica ceea ce s-a realizat deja, asa cum
este prezentat in literatura stiintifica de specialitate.

De aceea, referirea pe parcursul elaborarii tezei dar si in capitolul dedicat pentru stadiul
actual al cunoasterii, constituie modalitatea de a demonstra existenta unor elemente de
originalitate ale cercetarii doctorale.

Modul in care se va face citarea in textul tezei este prezentat sugestiv in modelul de
redactare de mai jos.

Capitolele tezei - care prezinta continutul propriu-zis al cercetarii (unul sau mai multe
capitole, cu subcapitolele aferente), reprezinta partea principala a tezei de doctorat.

Aceasta parte, cea mai extinsa a tezei, poate consta in: dezvoltarea/ adaptarea/
construirea unui concept, unui model matematic aplicat in domeniul tezei, demers
aplicativ nou, bazat pe date rezultate din experimente, simulari etc, relevante si
consistente in raport cu referintele din literatura.
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Aici sunt stabilite ipotezele de cercetare, sunt identificate/justificate/ dezvoltate cele mai
adecvate metode pentru testarea ipotezelor si pentru validari ale rezultatelor. Tot aici se
prezinta justificarea alegerilor facute cu privire la echipamente/ standuri pentru testare/
pachete software utilizate etc.

De regula, metode de cercetare trebuie sa fie recente. Utilizarea unei metode de
cercetare mai vechi in conditiile in care literatura de specialitate ofera solutii/tehnologii
noi si dovedite ca producand rezultate mai bune, cercetarea ar putea sa nu aduca
elemente de noutate.

Capitolele tezei trebuie sa aiba un titlu clar si concis care sugereaza complet continutul.

Capitolul/ sectiunea — Rezultate — poate fi capitol distinct sau poate sa fie un subcapitol
din continutul propriu-zis al cercetarii. Sectiunea referitoare la rezultatele cercetarii ar
trebui sa fie insotite de o etapa de validare.

Capitol — Comentarii si concluzii — au rolul de a clarifica semnificatia si implicatiile
rezultatelor cercetarii. In aceastd parte se face referire la originalitatea rezultatelor,
aplicabilitatea rezultatelor, limitele cercetarii si posibilele directii viitoare de cercetare. Pe
parcursul capitolelor din teza, la finalul fiecaruia doctorandul ar trebui sa introduca cateva
paragrafe concluzive care sa justifice si sa impuna urmatorul capitol al tezei.

Bibliografia — Contine resursele bibliografice folosite de studentul-doctorand Tn scopul
realizarii tezei de doctorat. Capitolul de referinte nu se numeroteaza insa este precizat in
Cuprinsul tezei. Poate fi adoptata si structura care contine o sectiune de referinte la
sfarsitul fiecarui capitol, insa oricum capitolul Bibliografie, la finalul tezei, nu trebuie sa
lipseasca din lucrare. Propriile lucrari publicate deja trebuie mentionate in bibliografie,
evidentiind distinct numele autorului intre autorii unei lucrari.

Anexele- sunt adaugate atunci cand este necesara detalierea extinsa. Ele pot contine
de exemplu datele folosite, liniile de program software dezvoltat, sau demonstratii mai
elaborate ale unor modele matematice folosite pe parcursul tezei etc.

Anexele au titlu si sunt numerotate si incluse si in Cuprinsul tezei.
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3. Model de redactare a tezei de doctorat
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Conducator stiintific Doctorand

Bucuresti, ......
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S$coain DoctoBIA TRAMSPORTURI

CUPRINS =

LISTA DE ABREVIERI
LISTA DE TABELE
LISTA DE hARTI

LISTA DE FIGURI
REZUMAT EXTINS
INFORMATII GENERALE

1. Titlul Capitolului 1 (Nivelul 1)
1.1. Tithul sectiunil (Nivelul 2)
1.2, Titlul sectiunil (Nivelut 2 )
1.2.1.  Tiiul Paragraful (Nivelul 3)

2. Titlul Capitolului 2
BiBLIOGRAFIE

AnexE

~n

Creat automat:

Insert > Refevence > Index and
Tables > Table of contents

si apol formatat manual ca
exemplul urmator

3
Verdana 14, all capitals, dark blue

/4
=,

Error! Bookmark not defined.

NN NN 0w s

10
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Exemple:
AFER

ARR
BCU
ECTS
EPP-ED
FAO
PIB

uPB

LISTA DE ABREVIERI

Autoritatea Feroviara Romana

Autoritatea Rutiera Romana

Biblioteca Centrala Universitara

European Credit Transfer System

Group of the European People's Party and European Democrats
Food and Agriculture Organisation of the United Nations

Produs Intern Brut

Universitatea POLITEHNICA din Bucuresti

Tl raportulul
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LISTA DE TABELE

TABELUL 1
Date statistice 5
TABELUL 2
Numar de vehicule inregistrate 6

LISTA DE FIGURI

FIGURA 1 \

Dependenta costurilor externe &Nb\wre a arterei 8
\ S
" S
N
/ N

[ Creat automatic:
Insert > Reference > Index and Tables >
Table of figures

si apoi formatat manual ca i exemplul
urmator.

.

Pentru a modifica in litere majuscule:
\ Format > Change Case > UPPERCASE /
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Tanl raportuil

Font: Anal, 10pt, Dark Blue, Line
REZUMAT spacing: Multiple. At 1.1
-~ (Format > Paragraph > Spacing),
"~ max 1500-2000 caractere

Elemente initiale

Tabelul 1: Date statistice

Valoare

Descriere monetara
<

9.950

4.900

6.660

2.000

3.975

4.000

9.450

Sursa: EUROSTAT (2008)

Se vor folosi doar formatele
corespunzatoare tabelului 1 s1 2 (a se
vedea tabelul 2 de la pag. 10)

Culoare : Gray, 10%
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>

INFORMATII GENERALE

ELEMENTE ESENTIALE (unde este cazul)

Caseta cu exemple din alte tari (unde este cazul)

7

\

Format: "Style Heading 1 + Anal 14 pt
Bold Dark Blue All caps”

Tabelul 2: Numar de vehicule inregistrate (un alt exemplu de tabel)

" 110 910 km?

Suprafata
Populatie \ 7718750
Densitatea populatiei (locuitori/ km?) ‘ 689

’ Lev (1€ =195 levs)

Moneda

Produs Intern Brut pe locuitor \ 38.1%
Rata de crestere ’ 6.2%
Rata somajului 6.9%

Sursa: EUROSTAT (2009)
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Tt raportukil

1. TITLUL CAPITOLULUI 1 (NIVELUL 1)

ELEMENTE ESENTIALE (daca este cazul)

Atentie 'Mithul capitolului este denumit de fiecare doctorand si poarta doar numarul in fata.

1.1. Titlul sectiunii (Nivelul 2)

........ vecexemplu  de insertie a referintei  bibliografice in  text.

Daca sunt ge: sam mm

1.2. Titlul sectiunii (Nivelul 2| =vitauton precizaes m

Daca smmt doar dor auton

text N veferintei precizare2 1m text a refennter
bibliografice este de Inbhografice este de foama
121 Titlul Paragraful (Nivelul forma . \\\
s (RoSCa Ot @, 2008)7............oocccimmreciassssssenis (Harta 1). ..........(Popa & Costescu, 2006)
Sursa: Website Consitul Judetean Itfoy
ATENTEE | INTOTDEAUNA SE SPECIFICA SURSA ORICARE! FIDAURE A ORICARLY TABEL ETT
specfica >>>>Sursa Aulons

Daca sl personale Jtunct se

10
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Harta 3: Harta administrativa a judetulul Iifov si comunelor Invecinate

2. TITLUL CAPITOLULUI 2
ELEMENTE ESENTIALE

Sursa; anul

Figura 5: Numar de utilizatori pe moduri de transport

11
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Titlul raporiuks

BIBLIOGRAFIE

{(exemple legate de modul in care trebuie specificata bibliogarfia ia sfarsit, dupa ce a fost
Iinserata in text acolo unde autorul a folosit-c)

European Commission (2006), Green Paper: Towards a futwe Maritime Policy for the Unlon: A
European vision for the oceans and seas, COM(2006) 275 final, Brussels

Popa Mihaela (2009) Economia transporturilor, Ed. POLITEHNICA PRESS, Bucuresti, ISBN 578-
606-515-036-2, 325 pg.

Popa Mihaela, Raicu, S., Rosca, E., Costescu Dorinela (2007) Optimal planning for developing.
modemizing and maintaining the street infrastructure of dense and large urban areas, in Urban
Transport and Environment in the 215t Century, Ed. C A Brebla, Wessex Institute of Technology
Press, Southampton, UK., ISBN 978-1-84564-087-3, pp.471-480.

Raicu, $., Popa Mihaela. Costescu Dorinela (2008) Managementul energiei in transportur, Tn
ntul sistemelor energetice, coord. Leca A. Editura AGIR, Bucuresti, editia a |l a, Editura
AGIR. pp.688-718.

Rogca E., Popa Mihaela, Rusca F. (2008) Transport network refiabilty and vuinerability in large wban
areas. Proceedings of the XVIll International Conference TRANSPORT 2008, 7-Nov. 2008, Sofla
Bulgaria (ISSN 1312-3823), pp. 1-26-31 publicata In Academic Journal Mechanics, Transport,
Communications (hifp//www.mtc-af com)

Popa Mihaela, Costescu Dorinels (2006) Can we apply & congestion pricing scheme in any large city?
The case of Bucharest city, 4th International Conference "Challenges In Transport and
Communication®, 14-15 September, 2006, Pardubice, Cehia, ISBN 80-7194-880-2. pp 221-226.
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ANEXE

10
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